SoftStep
Reference Manual
Created by Keith McMillen, Conner Lacy, Chuck Carlson, Evan Adams, Evan Bogunia, Diane Douglas, Tom Ferguson, Jay Fields, Matt Hettich, David Hishinuma, Sarah Howe, Daniel McAnulty, Dennis Saputelli, Dustin Schultz, Barry Threw, Nick Wang, Carson Whitley, and Steve Wright

This reference manual was written by Carson Whitley.

Copyright 2007-2014 Keith McMillen Instruments, a wholly owned subsidiary of Kesumo LLC. All rights reserved. Made in USA.

No part of this manual may be reproduced or transmitted in any form or for any purpose without the express written permission of the copyright holders.

The content of this manual is furnished for informational use only, is subject to change without notice, and should not be construed as a commitment by Keith McMillen Instruments. Every effort has been made to ensure that the information in this manual is accurate. No warranties, express or implied, are made with regard to the quality, suitability, or accuracy of this document. Keith McMillen Instruments reserves the right to change the contents of this document and/or the associated products at any time without the provision of prior notice to specific persons or organizations. Keith McMillen Instruments shall not be held liable for damages of any kind arising from the use, or the inability to use this product or its documentation, even if the possibility of such damage is known.

Product and brand names contained in this document are used for identification purposes only. Keith McMillen Instruments, the Keith McMillen Instruments Logo, the SoftStep and SoftStep logo are trademarks of Kesumo LLC. Apple, Finder, GarageBand, Logic, Mac, MacBook, Macintosh, Mac OS, and QuickTime are trademarks of Apple Inc, registered in the U.S. and other countries. Windows is a registered trademark of Microsoft Corporation in the United States and other countries. Intel is a registered trademark of Intel Corporation or its subsidiaries in the United States and other countries. All other product and company names are trademarks or registered trademarks of their respective holders. All other names and designations of companies, products, trademarks, or brands used in this document are the registered property of their respective holders.
# Table Of Contents

Welcome ........................................................................................................................................................................5
Questions? Feedback? Contact Us! .................................................................................................................................5

1.0 Before You Begin ..........................................................................................................................................................8
  1.1 What’s In The SoftStep Package? .............................................................................................................................8
  1.2 What’s In The MIDI Expander Package? .....................................................................................................................8
  1.3 System Requirements ..................................................................................................................................................8
  1.4 Conventions In This Manual .......................................................................................................................................9

2.0 Getting Started ...........................................................................................................................................................11
  2.1 SoftStep Hardware ....................................................................................................................................................11
    2.1.1 Overview ...........................................................................................................................................................11
    2.1.2 Specs ...............................................................................................................................................................12
  2.2 MIDI Expander Hardware ...........................................................................................................................................13
    2.2.1 Overview ...........................................................................................................................................................13
    2.2.2 Specs ...............................................................................................................................................................14
  2.3 Connecting SoftStep ..................................................................................................................................................15
    2.3.1 To A Computer ..................................................................................................................................................15
    2.3.2 To An iPad .........................................................................................................................................................16
    2.3.3 To MIDI Hardware ..............................................................................................................................................17
    2.3.4 To MIDI Hardware + Computer ..........................................................................................................................18
  2.4 Factory Presets Overview ............................................................................................................................................19
    2.4.1 The Presets .........................................................................................................................................................19
    2.4.2 Customizing Presets ............................................................................................................................................20
3.0 Basic Editor ................................................................. 22

  3.1 Main Window ............................................................... 22
     3.1.1 Keys ...................................................................... 22
     3.1.2 Settings ................................................................. 23
     3.1.3 Presets ................................................................. 24
     3.1.4 Nav Pad .................................................................. 25
     3.1.5 Menu Bar Options ................................................. 25
     3.1.6 Message Types ...................................................... 26
     3.1.7 Display Behavior .................................................. 29
     3.1.8 Factory Presets ..................................................... 29

4.0 Advanced Editor .......................................................... 32

  4.1 Main Window Overview .............................................. 32
     4.1.1 Key Boxes ............................................................ 33
     4.1.2 Display Name Box ............................................... 33
     4.1.3 Presets Section ..................................................... 33
  4.2 Key Modulation Window Overview ............................ 35
     4.2.1 Overview ............................................................ 35
     4.2.2 Modlines ............................................................. 35
     4.2.3 LED+Display Settings .......................................... 39
     4.2.4 Counter ............................................................... 40
     4.2.5 Add/Delete Modlines ............................................ 41
     4.2.6 Nav Pad Modulation Window ............................... 41
  4.3 Setlist Window ............................................................ 42
  4.4 Settings Window .......................................................... 43
     4.4.1 Overview ............................................................. 43
Welcome

Hello, and welcome to the SoftStep reference manual! The mere act of opening this document is a huge step toward SoftStep mastery!

The purpose of this document is to provide a resource with helpful, detailed information regarding the use of the SoftStep and SoftStep software.

Questions? Feedback? Contact Us!

Any questions or feedback that may come up regarding the SoftStep or its software can be directed to us here:

- **Technical Support**: [www.keithmcmillen.com/support](http://www.keithmcmillen.com/support)
- **General Questions**: [www.keithmcmillen.com/company/contact](http://www.keithmcmillen.com/company/contact)
- **Forum**: [forum.keithmcmillen.com](http://forum.keithmcmillen.com)
Before You Begin
1.0 Before You Begin

This section contains a few things to know before diving into the SoftStep world.

It’s okay to be overwhelmed with all of the options available. The SoftStep is a highly customizable controller, and with customization comes complexity. Like with all things, improvement is the result of practice.

1.1 What’s In The SoftStep Package?

The following items should be included in each SoftStep box (quantities will be in parentheses):

- (1) SoftStep
- (1) USB A to USB B cable – 15ft.
- (1) SoftStep protective sleeve
- (1) 3.5mm (1/8”) to 1/4” expression pedal adapter

1.2 What’s In The MIDI Expander Package?

The following items should be included in each KMI MIDI Expander box:

- (1) MIDI Expander
- (1) USB Power Supply (5V, 500mA) (includes power converter blades)
- (1) USB A to USB B cable (for connecting the Expander to the power supply)
- (1) USB A to mini-USB B cable (for connecting the SoftStep to the Expander)

1.3 System Requirements

**Hardware**

The SoftStep is a class-compliant USB MIDI device – it will work with any hardware or software that supports MIDI.

The SoftStep hardware itself will work on any operating system (assuming there is native USB and MIDI support). It can even work with computers that may not be able to run the editors but still support USB 2.0 and MIDI (editing presets will have to be done on another computer in this case).

**Software**

The SoftStep editors have more specific requirements than the SoftStep hardware.
Mac
- Mac OS 10.5 or later
- Intel Core 2 Duo 2.0 GHz or greater
- Roughly 100 MB free hard disk space
- A SoftStep 1 or SoftStep 2 foot controller (both are fully compatible with the 2.0 software)

Windows
- Windows XP, Windows 7, or Windows 8 (we do not support Windows Vista)
- Intel Core 2 processor or greater
- Roughly 100 MB free hard disk space

1.4 Conventions In This Manual
Here are a few notes on the formatting of this document, particularly in relation to the platform you may be using:

- ▲ denotes an important note or piece of information – a “head’s up” symbol.
- Any graphical representation of the SoftStep hardware will use images of the SoftStep 2 hardware throughout the manual, but all information (unless explicitly noted) applies to SoftStep 1 hardware as well.
- Links to external websites will appear in underlined, blue text – click on the text to open that web page in the computer’s default web browser. Links to different sections of the manual will appear in black, bold, underlined text – click on the text to jump to that section of the manual. Key terms that do not link anywhere will simply be in bold text.
- Screenshots in this document were made with the Mac version of the SoftStep editors.
- The term “port” will be used often throughout this manual. “Port” can refer to a physical port (e.g. a USB port) or it can refer to a virtual MIDI port or bus (used in audio software on computers/tablets to send and receive MIDI data).
- When referring to a virtual MIDI “port” or “bus”, the term “port” will be used.
- The terms “TRS cable” and “TS cable” will appear in the manual – these are also commonly referred to as a “stereo cable” and “mono cable”, respectively.
- Any measurement value followed by double quotes (“”) denotes inches. Measurement values followed by a single quote (’) denotes feet – e.g. 1/4” refers to one-quarter inch and 3’ refers to three feet.
- “MIDI cable” will be used throughout the manual when referring to a 5-pin DIN cable.
Getting Started
2.0 Getting Started

This section will cover information that will help get started with the SoftStep (What? No way!). We will introduce the SoftStep hardware, the MIDI Expander hardware, and how to connect the SoftStep to the world.

2.1 SoftStep Hardware

The SoftStep hardware!!!

2.1.1 Overview

(1) Keys

Keys are where the action happens. Step on these to make the SoftStep perform it’s defined functions.

Each key has a green and red LED (at the northeast corner of the key) for visual feedback.

(2) Nav Pad

Short for “navigation pad”. Press left or right to change presets. Up/Down can be programmed to perform a number of different functions.

(3) Display

Used for visual feedback. The SoftStep’s display can show what preset is currently loaded, the name of an activated key, and real-time parameter values.

(4) USB Ports

Used to connect SoftStep to the MIDI world. Connect a KMI MIDI Expander using the Expand port (mini-USB) or connect to a computer/tablet via the main USB port (the big one).
(5) Pedal Input

Used to connect an expression pedal to the SoftStep. All input should use a 3.5mm (1/8") TRS cable to work properly. Most expression pedals have a stereo 1/4” jack – an expression pedal adapter (female 1/4” TRS to male 3.5mm TRS) is included with every SoftStep.

2.1.2 Specs

The “deets”:

**Dimensions & Weight**
- **Dimensions**: 4.1” x 17.7” x 0.94” (105mm x 450mm x 24mm)
- **Weight**: 1.3 lbs (0.59 kg) (approximately)

**Power Draw / Requirements**

The SoftStep can be powered via the main USB port or the Expander port. It should never be powered from both ports at the same time – this may result in damage to the hardware.

- **Voltage**: +5V
- **Power draw**: SoftStep 1 = 105mA, SoftStep 2 = 140mA (approximate measurements)

⚠️ **Note**: There are no user serviceable parts inside the SoftStep. Attempts to open the enclosure will void the warranty.
2.2 MIDI Expander Hardware

The KMI MIDI Expander is an optional accessory that allows the SoftStep to connect to external MIDI hardware via MIDI cables.

2.2.1 Overview

(1) MIDI In
MIDI input to the Expander. Incoming MIDI will be passed through the SoftStep and up the USB connection to a connected computer or tablet – similar to a MIDI interface. MIDI sent into the Expander’s input can also be used to control the SoftStep LEDs, display, and presets.

(2) MIDI Out
MIDI output from the Expander. MIDI from the SoftStep (and a connected computer) can be sent out of this to external MIDI hardware.

(3) Input LED Indicator
Flashes when MIDI is received at the MIDI In port.

(4) Output LED Indicator
Flashes when MIDI is sent out of the MIDI Out port.

(5) Power Port
Used to power the MIDI Expander and an attached SoftStep. Just plug a USB power supply (one is provided with the Expander package) into an outlet, then connect the power supply to the POWER port on the Expander with a USB A to B cable (also provided with the Expander).

⚠️ Note: If nothing is plugged into the EXPAND port when powered, the Expander’s Input and Output LED Indicators will light up. This is just to indicate that the Expander is being powered – no MIDI is actually being output or received. Once a KMI controller is connected to the EXPAND port they will turn off and behave normally.
(6) Expand Port

Used to connect the MIDI Expander to the SoftStep. Just use a mini USB cable to connect the SoftStep’s Expand port to the Expander’s EXPAND port.

⚠️ **Note:** Only KMI MIDI controllers should be connected to the EXPAND port – other USB MIDI controllers and USB hubs will not work properly.

### 2.2.2 Specs

**Dimensions & Weight**

- **Dimensions:** 4” x 1.25” x 1.25” (102mm x 32mm x 32mm)
- **Weight:** 2.5 oz. (71g)
2.3 Connecting SoftStep

The SoftStep can talk to computers and tablets via USB, and MIDI hardware via MIDI cables (KMI MIDI Expander required). Both methods can be used independently or simultaneously.

2.3.1 To A Computer

Connecting the SoftStep to a computer requires three things: a SoftStep, a computer, and a USB A to USB B cable (the “classic” USB cable). Simply plug the SoftStep’s main USB port into a USB 2.0 (or greater) port on the computer. The SoftStep will receive power from the computer.

⚠️ Note: The SoftStep can also be used with a USB hub connected to a computer. It is highly recommended to use a powered USB hub, not a bus-powered hub. Bus-powered hubs may not be able to provide enough power to the SoftStep to function properly.
2.3.2 To An iPad

Connecting the SoftStep to an iPad is very similar to connecting to a computer, the only difference is that one more part is needed.

An Apple Lightning to USB Camera Adapter (for iPads with Lightning connectors) or an Apple iPad Camera Connection Kit (for iPads with the older 30-pin connectors) is required to connect the SoftStep to an iPad via USB.

Plug the adapter into the iPad, plug the SoftStep’s main USB port into the adapter with a USB A to B cable, and everything is ready to go.

⚠️ **Note:** Some iPad models may not be able to power the SoftStep without some help – the SoftStep may have to be powered externally with a USB power supply (5V, 500mA). Just plug the SoftStep’s mini-USB port (the Expand port) into the power supply, then plug the power supply into a power outlet.
2.3.3 To MIDI Hardware

A KMI MIDI Expander is required to connect to MIDI hardware via MIDI cables.

1. Connect the SoftStep’s EXPAND port to the EXPAND port on the Expander using a USB A to mini-B cable.

2. Connect the Expander’s POWER port to a USB power supply (included with Expander package) using a USB A to B cable.

3. Plug the power supply into a power outlet – the SoftStep and Expander should power up.

4. Use a MIDI cable to connect the Expander’s MIDI OUT to the MIDI IN on the external hardware. Use a second cable to connect the Expander’s MIDI IN to the MIDI OUT on the hardware if input to the SoftStep is desired.
The SoftStep can be connected to both a computer and external MIDI hardware at the same time (KMI MIDI Expander required).

1. Connect the SoftStep’s EXPAND port to the EXPAND port on the Expander using a USB A to mini-B cable.

2. Connect the SoftStep’s main USB port to the computer using a USB A to B cable. The SoftStep and Expander should power up.

3. Use a MIDI cable to connect the Expander’s MIDI OUT to the MIDI IN on the external MIDI device.
2.4 Factory Presets Overview

The SoftStep comes loaded with a number of factory presets right out of the box. Some cover very basic functions (program changes, toggles, MIDI notes, pressure), and a few work with some software/hardware integration examples.

This is just a very brief overview of the factory presets. For more detailed information about each of the factory presets, please see the Factory Presets Guide section in the Appendix.

2.4.1 The Presets

Use the left and right keys on the Nav Pad to switch between presets.

All factory presets transmit on MIDI channel 1 and are set to output over both USB and MIDI Expander (if one is connected).

The following presets ship pre-loaded on the SoftStep hardware:

**Program Change (PRGM)**

Each key outputs a program change message. Use the up and down keys on the Nav Pad to increment/decrement the program changes being output by ±10’s.

**Toggles (TOGL)**

Each key outputs a toggling CC message (CCs 20-29). Step on a key and it toggles on, step on that key again and it toggles off.

**Notes (NOTE)**

Each key outputs a MIDI note (notes 60-69). Step on a key to send a note on message, release the key to send a note off message.

**Pressure (PRES)**

Each key outputs a key's pressure as a CC message (CCs 110-119). More pressure makes the value go higher, less pressure makes the value go lower.

**ElevenRack Control (11RK)**

This preset works with an Avid Eleven Rack processor. A MIDI Expander is required to connect to the Eleven Rack. The top row of keys turn effects on and off – the bottom row modulates the effects’ parameters.

**Line6 Pod Control (POD)**

This preset works with most Line 6 processors, including the Pod. A MIDI Expander is required to connect to the Pod. The top row of keys turn effects on and off – the bottom row modulates the effects’ parameters.
Ableton Live Control (LIVE)

This preset works with our custom Ableton Live script. Control the transport with the top row of keys – control track volumes with the bottom row.

Instructions on how to install this can be found in the “Extras” folder of the SoftStep 2.0 software package.

2.4.2 Customizing Presets

While the factory presets cover some basic, general functions, some users may desire more advanced and customized behavior. The SoftStep’s presets can be completely customized using the SoftStep Basic Editor or the SoftStep Advanced Editor.

The Basic Editor will cover most peoples’ needs – it allows for ten presets where each key can perform a single function. The Advanced Editor is there when more complex behavior is needed – it allows for up to 16 presets where each key can perform multiple functions (all customizable).
Basic Editor
3.0 Basic Editor

The SoftStep Basic Editor is a great way to customize SoftStep presets when quick, simple functions are desired (which is often the case). The Basic Editor offers ten presets where each key performs a single function. Keys can output a MIDI note, act as a CC toggle, output key pressure, send X/Y location data, send program change messages, or emulate a vertical slider – users' most common needs.

3.1 Main Window

The main window is the only window in the Basic Editor – it's where everything happens (though there are also a few options up in the menu bar). This is the main window:

3.1.1 Keys

This area is where the behavior of the SoftStep keys is defined. The keys are laid out in the editor as they appear on the SoftStep hardware. Each key looks a little like this (at right):

1. **Key # Label**
   
   The SoftStep key number. Nothing special – it's just a label.

2. **Key Name Box**
   
   Enter up to four characters to give the key a name. This name will be used on the SoftStep display in certain situations. For detailed information on how the display behaves for each message type, please see the Display Behavior section.
(3) **Message Type Selector**

Click on one of the six blue radio buttons to select a message type for the key. Message types tell the key what it should do when pressed.

Deactivating a key is possible by clicking the currently active message type button. All sources will be disabled and the key will no longer output anything.

Selecting a message type will show some settable parameters that further define how the key should behave. Each message type has different parameters. Detailed information on message types and their parameters can be found in the [Message Types (Basic Editor)] section.

(4) **Message Type Parameters**

The message type parameters are a few settable options for the selected message type – they include a few more details on how a key should behave.

MIDI Note, for example, allows selecting the note number, velocity, and whether or not it should toggle when the key is pressed. X/Y allows selecting a CC number for both the X and Y parameters, and whether or not the CCs should latch when the key is released.

More detailed information on message types and their parameters can be found in the [Message Types (Basic Editor)] section.

3.1.2 Settings

(1) **Connected Indicator**

Displays whether or not the editor has made a connection to an attached SoftStep controller. A connection is required to use update firmware, send presets to the SoftStep, and alter the SoftStep’s settings. A connection is not needed to edit or manage presets.

(2) **Sensitivity**

Adjusts the sensitivity of the SoftStep. Higher values are more sensitive – lower values are less sensitive. For the more math savvy, this number acts as a multiplier on the sensor data.

- Range: 0.00-2.55
- Default Value: 1.00
(3) Backlight
Turns the SoftStep backlighting on or off. Check this box to turn it on – uncheck this box to turn it off.

(4) MIDI Channel
Sets the MIDI channel the SoftStep will send MIDI on.
- Range: 1-16
- Default Value: 1

(5) Nav Pad CC#
Sets the CC number the Nav Pad will send on. See the Nav Pad section for details on how it functions in the Basic Editor.

(6) Pedal CC#
Sets the CC number that a connected expression pedal will send MIDI on. All Basic Editor presets have expression pedal functionality enabled.

(7) Display Name
Sets the display name for the currently selected preset. This name will be displayed when switching between presets on the SoftStep, so a unique, identifiable name is recommended. Up to four characters may be used.

3.1.3 Presets

(1) Current Preset
Selects a preset for editing. The Basic Editor allows for ten different presets, 1-10.

(2) Save Button
Saves any changes made to the current preset. The save button will light up red if any unsaved changes have been made.

(3) Revert Button
Restores a preset to its saved state. Any unsaved changes will be lost.
3.1.4 Nav Pad

In the Basic Editor, the Nav Pad’s behavior is not customizable (aside from the CC number). In each preset, the Nav Pad behaves as though it is set to Y Inc – pressing up on the Nav Pad will increment the CC value (between 0-127), and pressing down on the Nav Pad will decrement the CC value. Great for controlling faders, sliders, and knobs.

The CC number the Nav Pad is sending on can be changed using the **Nav Pad CC #** option in the **Settings** area.

3.1.5 Menu Bar Options

There are a number of useful functions and settings that can be accessed via the menu bar at the top of the screen (Mac OS) or at the top of the application window (Windows). Manage presets, copy/paste keys, manage firmware, and more.

The following menu bar options are available:

**SoftStep Basic Editor**

This option is only available on Mac OS. Windows users can find the options listed below in the **Help** menu.

**About SoftStep Basic Editor**

Displays information about the SoftStep Basic Editor, including the expected firmware version and the found firmware version.

- **Editor Version**: Displays the version number of the editor.
- **Expected**: Displays which firmware version is provided in this version of the Basic Editor. This is the version that will be loaded onto a connected SoftStep when a firmware update is initiated.
- **Found**: Displays the firmware version currently loaded on a connected SoftStep.

**File**

The File menu contains options related to exporting/importing files.

**Export Preset**

Allows for exporting the currently selected preset as a file. The resulting .softstepbasicpreset file can later be imported to the Basic Editor. Great for backups and moving presets to another computer!

**Import Preset**

Allows importing a .softstepbasicpreset file over the currently selected preset. When importing, the current preset’s parameters will be altered but not saved (so the revert button can always be used to undo the changes).
**Edit**
The Edit menu contains options related to modifying presets in some way.

- **Copy Preset**
  Copies all of the current preset’s settings (to be used for pasting later).

- **Paste Preset**
  Applies a copied preset’s settings to the currently selected preset.

- **Use Custom Preset**
  The currently selected preset will use the Basic Editor to create a custom preset.

- **Use Factory Preset**
  Use this to choose a factory preset (from the Advanced Editor) to use in place of the currently selected Basic Editor preset. When using a factory preset, the Keys area will grey out and display the text: “Using Factory Preset: [preset name here]”.

**Hardware**
The Hardware menu contains options related to the SoftStep pedal itself.

- **Update/Reload Firmware**
  This option will manually initiate a firmware update/reinstallation.

**Help**
The Help menu contains options related to documentation/information.

- **Documentation**
  Navigates to the SoftStep documentation using the default web browser.

- **Show/Hide Tooltips**
  Selecting this option will toggle between hiding and showing the tooltip pop ups displayed when hovering the mouse cursor over an object.

### 3.1.6 Message Types

Message Types define how a key behaves and what type of MIDI message it will output when pressed. The following message types are available in the Basic Editor:

- **MIDI Note**
  The MIDI Note option tells a key to output a MIDI note. A note-on message will be sent when the key is pressed, and a note-off message will be sent when the key is released. This behavior can be changed to a toggle-like function by using the Toggle option.

  The following options are available when MIDI Note is selected:
Note #
Sets which MIDI note to output.
• Range: 0-127

Velocity
Specifies the velocity of the MIDI note being output.
• Range: 0-127

Toggle
The Toggle checkbox enables/disables toggle mode. When checked, the first time the key is pressed a note-on message will be output – the next key press will send a note-off message. Uncheck this box for normal note behavior (note-on when key is pressed, note-off when key is released).

Pressure
The Pressure option will make a key output its current pressure value as a CC message. Applying more pressure makes the value go higher – less pressure makes the value go lower.
The following options are available when Pressure is selected:
  CC #
  This box sets the CC number to output the pressure value on.
  • Range: 0-127

Smooth
  This box sets the amount of smoothing to apply to the pressure data. Higher values add more smoothing – lower values add less smoothing (0 = no smoothing).

Toggle
The Toggle option will tell a key to output a toggling CC message. Each key press will alternate between the set high and low values.
The following options are available when Toggle is selected:
  CC #
  This box sets the CC number to output the toggle on.
  • Range: 0-127

Lo / Hi
  These are used to set the low and high values the toggle will alternate between. The first key press will output the high value, the next press will output the low value.
  • Range: 0-127
X/Y

The X/Y option allows a key to output X (left-right) and Y (down-up) location data as CC messages. X-axis and Y-axis data may be used separately or simultaneously.

The following options are available when X/Y is selected:

**X CC #**

This box sets the CC number to output the X-axis location data on.

- Range: 0-127
- Enter -1 (negative one) to disable the X-axis CC.

**Y CC #**

This box sets the CC number to output the Y-axis location data on.

- Range: 0-127
- Enter -1 (negative one) to disable the Y-axis CC.

**Latch**

The Latch checkbox enables and disables latch mode on the X and Y CCs. When checked, the X and Y CCs will stay where they were (“latch”) when the key is released. When unchecked, the X and Y CCs will return to center (63) when the key is released.

**Y Inc**

Short for Y Increment, this option will turn a key into a virtual slider. Putting pressure on the top portion of the key will make the value increment – putting pressure on the bottom portion of the key will make the value decrement.

The following options are available when Y Inc is selected:

**CC #**

Sets the CC number to output the Y Increment value on.

**Program**

The Program option allows a key to output a program change and/or bank select message when pressed.

The following options are available when Program is selected:

**Program #**

Sets the program change number to output when this key is pressed.

- Enter -1 (negative one) to turn off the program change message.

**Bank #**

Sets the bank select number to output when this key is pressed.
• Enter -1 (negative one) to turn off the bank select message.

⚠️ **Note:** If bank select messages above 127 are needed then it is necessary to use the SoftStep Advanced Editor. The Basic Editor's bank select messages have the MSB fixed at 0, which only allows access to banks 0-127.

### 3.1.7 Display Behavior

The SoftStep display behaves differently depending on which message type is selected.

- **MIDI Note**: Displays the key name when pressed.
- **Pressure**: Live numerical display of the current pressure value.
- **Toggle**: Displays the key name when pressed.
- **X/Y**: Live numerical display of the current X/Y value.
- **Y Inc**: Live display of the current inc/dec position.
- **Program**: Displays the key name when pressed.

### 3.1.8 Factory Presets

The Basic Editor comes preconfigured with ten factory presets — most recreate the factory presets that ship pre-loaded on the SoftStep hardware (see Factory Presets Overview), a few others showcase other Basic Editor options.

The following presets come included with the Basic Editor:

**NOTE**

Each key outputs a MIDI note (notes 60-69). Step on a key to send a note on message, release the key to send a note off message.

**PRES**

Each key outputs a key's pressure as a CC message (CCs 110-119). More pressure makes the value go higher, less pressure makes the value go lower.

**TOGL**

Each key outputs a toggling CC message (CCs 20-29). Step on a key and it toggles on, step on that key again and it toggles off.

**XY**

Each key outputs its X (left to right) and Y (bottom to top) location data as two separate CC messages. The X-axis CCs go from 20 to 29 – the Y-axis CCs go from 30-31.

**Latch** mode is enabled on each key, so the X and Y CCs will stay wherever they are when the key is released. If returning to center is desired, this can be modified using the editor.
YINC

Each key is set to Y Inc – which acts like a vertical slider. Pressure on the top half of a key will increment the value – pressure on the bottom half of a key will decrement the value.

PROG

Each key outputs a program change message when pressed. The keys cover program changes 21-30.

11RK

A recreation of the Eleven Rack factory preset. Use this to control an Avid Eleven Rack processor.

POD

A recreation of the Line 6 Pod factory preset. Use this to control a Line 6 Pod amp modeler.

XYLV

Short for “X/Y Live”, this preset is exactly the same as the XY preset except the Latch parameter is disabled – each key will return to center (63) when released.

PRGM

Another program change preset. This one makes use of the Basic Editor’s “Use Factory Preset” functionality to load the Program Change factory preset.
Advanced Editor
4.0 Advanced Editor

While the Basic Editor covers the most commonly used functions, sometimes more complex setups are desired – that is where the Advanced Editor comes into play.

The SoftStep Advanced Editor allows for up to 16 fully customizable presets – each key can have multiple functions, LED behavior can be customized, and more sensor response settings allow for fine-tuning the SoftStep's playability.

4.1 Main Window Overview

Upon first opening the Advanced Editor the main window will be displayed. This is the gateway to everything – customizing keys, opening the settings and setlist windows, and preset management.

The main window looks something like this:

(1) Key Boxes: (see Key Boxes section)

(2) Display Name Box: (see Display Name Box section)

(3) Hosted/Standalone Switch: Switches between Hosted mode and Standalone mode.

(4) Setlist Button: Opens the Setlist window.

(5) Settings Button: Opens the Settings window.

(6) Connection Indicator: Displays whether or not the editor has made a connection to an attached SoftStep controller. A connection is required to use Hosted mode, update firmware, send presets to the SoftStep, and alter the SoftStep's settings. A connection is not needed to edit or manage presets.
4.1.1 Key Boxes

The key boxes in the Advanced Editor’s main window are laid out just as the keys on the SoftStep hardware are – keys 1-5 on the bottom row, keys 6-0 on the top row (and Nav Pad to the right). Key boxes allow for naming a key, opening a key’s modulation window, and selecting a key for copying/pasting.

A single key box contains the following sections:

1. **Box Background**
   
   Clicking the key box background selects that key for copy/paste functionality. A selected key can be copied or pasted using the Copy or Paste options in the Edit menu bar item.

2. **Label/Open Mod Window**
   
   Clicking this opens the key’s Modulation Window.

3. **Name Box**
   
   The name box allows for naming a SoftStep key. Key names are used with the SoftStep’s display in certain situations.

   Note: The key name can also be edited inside a key’s modulation window).

4.1.2 Display Name Box

The display name box is used to set the name that appears on the SoftStep’s display when a preset is loaded (four characters maximum). It is recommended to give each preset a recognizable, distinctive name to prevent confusion when navigating presets on the SoftStep.

4.1.3 Presets Section

The top-left area of the Advanced Editor’s main window is home to the presets section. This is where presets are selected and where all preset management is handled.

The presets section looks like this:
(1) Preset selection drop-down
Clicking this displays a list of all presets. Choosing one loads it as the currently active preset.

(2) Save button
Saves any changes made to the current preset when clicked. The save button will light up red if any unsaved changes have been made.

(3) Save As button
Saves any changes made to the current preset to a new preset when clicked. The preset that was previously being edited will revert to its last saved state.

(4) Revert button
Restores a preset to its saved state. Any unsaved changes will be lost.

(5) Delete button
Deletes the currently selected preset. A confirmation dialogue will appear when clicked to prevent accidental deletions.

(6) Send to SoftStep button
(Standalone mode only)
Updates the connected SoftStep with any presets currently in the setlist.

Other preset-related info

Importing/Exporting Presets
Presets can be exported from and imported to the Advanced Editor. See the Import Preset and Export Preset section for more detailed information.

Import 1.21 Presets
It is possible to import presets created with the previous version of the SoftStep editor. See the Import Hosted/Standalone Presets From v1.21 section for more detailed information.

Hosted vs. Standalone Mode
While it may look like there is only a single list of presets, there are actually two lists – one for Hosted mode and one for Standalone mode. Switching between modes automatically switches the preset list over accordingly.
4.2 Key Modulation Window Overview

Each key (including the Nav Pad) has what we call a "modulation window". A key’s modulation window is where it’s behavior is defined.

4.2.1 Overview

A key modulation window looks like this:

1. Modlines — See Modlines.
2. LED+Display Settings — See LED+Display Settings.
3. Counter — See Counter.
4. Add/Delete Modlines — See Add/Delete Modlines.

4.2.2 Modlines

The main part of a modulation window is the modline area. Modlines tell the SoftStep keys what they should do – select the type of data, how to process the data, and how to output the data.

Each key can have up to 6 active modlines – each performing a completely different function.

This is a modline:

Information travels from left to right through the modline.
4.2.2.1 Enable Buttons
Enables/Disables the modline.

4.2.2.2 Inits
Inits (short for “Initializations”) allow for initializing parameters/modlines when a preset is loaded. Inits consist of two parts: a mode and a value.

    Mode
    The mode defines how the init behaves. More detailed information on each of the available modes can be found in the Inits section of the Appendix.

    Value
    Sets the value to output when the init is triggered. This value will be passed through the modline it is placed on.

4.2.2.3 Data Sources
The Data Sources section of the modline selects what type of sensor data (coming from the SoftStep) to use.

    Source
    Selects the type of sensor data to use – e.g. key pressure, foot on, foot off. For a complete list of all available sources (and what they do), see the Sources section of the Appendix.

    Raw
    (Hosted mode only)
    A live display of sensor data coming from the selected source.

4.2.2.4 Data Modifiers
The Data Modifiers section allows the values coming from the selected source to be processed in various ways – add a multiplier or offset, set min and max values, add some smoothing, and more.
Gain
Multiplies incoming values by the specified amount. Defaults to 1.00.

Offset
Adds the specified amount to incoming values. Use negative numbers for subtraction. Defaults to 0.

Result
(Hosted mode only)
A live display of the modline values after passing through the gain and offset stage.

Table
Sets the type of curve to apply to the incoming values. Also used for toggle behavior and interacting with the key counter. For a complete list of all available tables (and what they do) see the Tables section of the Appendix.

Min
Sets the minimum value that can be output. All values below the minimum will be clipped to this value – they are not ignored.

Max
Sets the maximum value that can be output. All values above the maximum will be clipped to this value – they are not ignored.

Smooth
Adds smoothing to the data.
Sets the amount of time (in milliseconds) it takes to slide/interpolate to the next value. Smaller values can smooth out jumpy data, while larger values can create longer ramps between values.
• Range: 0 - 5000ms

Delay
(Hosted mode only)
Applies a delay to the data.
Sets the amount of time (in milliseconds) to delay the incoming values.
• Range: 0 - 5000

Value
(Hosted mode only)
A live display of the modline values after passing through the data modifiers section.
4.2.2.5 Output Settings

The Output Settings section is where the modline is told how it should output the data coming through.

1. **Message Type**
   Sets the type of MIDI message (or a couple of other message types) to output. For a complete list of all available message types (and what they do), see the Message Types section of the Appendix.

2. **Message Type Options**
   Each message type has up to three settable options when selected. These further define how the message type should behave – e.g. what MIDI note number and velocity to output, what CC number to send on, or what channel to output program change values on.

3. **Output Port**
   Selects the MIDI port/device the modline messages will be sent out to.
4.2.3 LED+Display Settings

Hidden by default, the LED+Display Settings section can be accessed by clicking the LED+DISPLAY SETTINGS button in the top-right corner of the key modulation window.

These settings are part of the modlines and define how a SoftStep key's green and red LEDs behave, as well as how the SoftStep display behaves when the key is pressed.

When displayed, the LED+Display Settings look like this:

(1) Show/Hide Switch
Shows and hides the LED+Display Settings section of the modulation window. The settings still apply when hidden.

(2) Key Name
Sets the name of the key. Key names are used with the SoftStep's display in certain situations (defined by the Display Mode option).

⚠️ Note: Key names can also be edited in the key box area of the editor's main window.

(3) Display Mode
Sets how the SoftStep's display should behave when the key is pressed. For a complete list of all available display modes (and what they do), see the Display modes section of the Appendix.
(4) Prefix
One or two characters that can be added in front of the parameter value on the SoftStep’s display – e.g. with a prefix of “FF” and a modline value of 57, the display would read “FF57”.
Leave blank for no prefix.

(5) Green LED
Sets the behavior of the key’s green LED. For a complete list of all available LED modes (and what they do), see the LED Modes section of the Appendix.

(6) Red LED
Sets the behavior of the key’s red LED. For a complete list of all available LED modes (and what they do), see the LED Modes section of the Appendix.

(7) Active Display Modline Selector
Selects which modline’s data will be used for the Display mode settings. Only one modline can be selected per key.

4.2.4 Counter
The key counter increments/decrements (or “counts”) between two set values – a minimum and a maximum. Interacting with the counter is accomplished using the Counter Set, Counter Inc, and Counter Dec tables in the modlines.

Min
Sets the minimum value for the key counter. No values below this will be output.

Max
Sets the maximum value for the key counter. No values above this will be output.

Wrap
When checked, the key counter will loop back to the minimum value once the maximum value is exceeded (and vice versa). When unchecked, the counter will stop once the minimum or maximum values are reached.
4.2.5 Add/Delete Modlines

The “plus” button adds a modline (maximum of 6 per key) and the “minus” button deletes a modline (minimum of 2).

When deleting a modline, the settings are preserved but the modline is disabled. This allows the modline to be added back if it was deleted by mistake and also prevents potential confusion that could arise if there were active, hidden modlines.

4.2.6 Nav Pad Modulation Window

The Nav Pad’s modulation window has a few differences from the other keys’ modulation windows.

- There are no green or red LED options available since there are no LEDs for the Nav Pad.
- There is a slightly different source list than the other keys (see Nav Pad Sources in the Appendix for a complete list of Nav Pad-exclusive sources).
- The Nav Pad has a Mode setting in the top-left corner with two options: “modline” and “program change”
  - **Modline**: Use the Nav Pad with the modlines like a normal key.
  - **Program Change**: For use with the Nav Yx10 & Key source – this allows the Nav Pad to count “decades” (increments of 10) from 0 to 12 (or whatever the counter’s min and max are set to). This option will disable the use of modlines on the Nav Pad.
4.3 Setlist Window

The Setlist allows up to 16 presets to be ordered in any way. This is the order that the presets will appear on the SoftStep when pressing the left and right keys on the Nav Pad.

Overview

The setlist window will look something like this:

![Setlist Diagram]

(1) Enable/Disable Buttons
Enables/Disables the preset slot. Blue = enabled, black = disabled.

(2) Preset Selection Drop-down
Selects which preset to place in the setlist slot.
Hosted vs. Standalone mode

It may look like there is only one setlist, but there is a separate setlist for both Hosted mode and Standalone mode. When in Hosted mode the setlist window will display the Hosted mode setlist – when in Standalone mode the setlist window will display the Standalone mode setlist.

4.4 Settings Window

The Settings window is where a number of options reside – most of them pertaining to the sensor response of the SoftStep.

4.4.1 Overview

Upon first opening the Settings window, it will look something like this:

(1) Tabs
The Settings window is split up into four tabs: Global, Keys, I/O, and Pedal. Click one to switch to that tab.

(2) Settings (area below tabs)
The area below the tabs is where the relevant settings are displayed and set.

4.4.2 Global Tab

The Global tab contains settings that apply to the entire SoftStep. Turn the backlighting on/off, adjust the sensor response, change the sensitivity, and more.

Backlighting On/Off
Turns the SoftStep backlighting on or off.

Scene Changing On/Off
(Standalone mode only)
Enables/Disables scene changing using the left and right keys on the Nav Pad.

Sensor Response Max/Avg
Sets how the SoftStep sensors (four per key) determine overall key pressure.
- **Maximum**: Looks at only the highest valued sensor to determine key pressure.
- **Average**: Averages the four sensors together to determine key pressure.
Display Mode Switch
(Standalone mode only)
Switches the SoftStep display behavior for program changes. Data can be displayed in the 0-127 range or the 1-128 range.

Key Safety Mode
Sets how many keys can be activated simultaneously.

- **Single Key**: Only one key can be activated at a time.
- **Adjacent Lockout**: (Hosted mode only) Keys immediately adjacent to an activated SoftStep key cannot be triggered.
- **All Keys**: Any key can be activated at any time.

Sensitivity Adjustment
Adjusts the sensitivity of the SoftStep. Moving the slider to the right (toward the “+” symbol) increases sensitivity – moving the slider to the left (toward the “-“ symbol) decreases sensitivity. Clicking the RESET SENSITIVITY button will reset the sensitivity slider to its default value.

4.4.3 Keys Tab
The Keys tab contains settings that apply to individual keys on the SoftStep. Adjust on and off thresholds for each key or change X/Y Increment speeds per key.

Keys Section
The Keys section contains settable parameters for each of the SoftStep keys. Each numbered row corresponds to the key of the same number.

**X Inc Speed**
Sets the speed at which the X Increment source increments/decrements. Higher values make the source move faster – lower values make the source move slower.

**Y Inc Speed**
Sets the speed at which the Y Increment source increments/decrements. Higher values make the source move faster – lower values make the source move slower.
On Threshold
Sets the amount of pressure necessary to consider the key "on" (or “triggered”). Higher values require more pressure – lower values require less pressure.

Off Threshold
Sets the amount of pressure necessary to consider the key “off” (or “released”). Higher values will make the key turn off sooner (pressure doesn’t have to drop much) – lower values will make the key turn off later (pressure has to drop very low).

Nav Pad Section
The Nav Pad options behave exactly the same way as their normal key counterparts. The only difference is there are options for each direction of the Nav Pad – north, south, east, west.

4.4.4 I/O Tab
The I/O tab contains MIDI and OSC input options.

MIDI Input
(Hosted mode only)
The MIDI Input section contains options for receiving MIDI from other connected MIDI devices or software.

There are 8 MIDI inputs available – A through H. These can be accessed in the modlines by using the MIDI A-H sources.

 Enables
 Enables/Disables this MIDI input.

 Device
 Sets the MIDI device to receive data from.

 Channel
 Sets the MIDI channel to listen for. All MIDI coming in on other channels will be ignored.

 Message Type
 Sets the message type to listen for. All other message types will be ignored. The following options are available:

• **Note**: Listens for MIDI notes.

• **CC**: Listens for CC messages.

• **Program Change**: Listens for program change change messages.
Sets the specific note/CC/program change number to listen for. All other numbers will be ignored.

**Value**
Live display of the incoming value. This is the value that will get passed to the modlines when using the **MIDI A-H** sources.

**OSC Input**
(Hosted mode only)
The OSC Input section contains options for receiving (and one sending option) OSC from other OSC-capable software/devices.

There are 8 OSC inputs available — A through H. These can be accessed in the modlines by using the **OSC A-H** sources.

**Enables**
Enables/Disables this OSC input.

**Prefix**
Sets the OSC prefix to listen for. All other prefixes will be ignored.

**Value**
Live display of the incoming value. This is the value that will get passed to the modlines when using the **OSC A-H** sources.

**Sending IP Address**
Sets the IP address that OSC messages will be output on.
- Default: 127.0.0.1 (localhost)

**Out Port**
Sets the port number OSC will be output on.
- Default: 7000

**In Port**
Sets the port number to listen to for incoming OSC messages.
- Default: 7001
4.4.5 Pedal Tab

The Pedal tab contains the expression pedal calibration and smoothing options.

Overview

The Pedal tab looks like this:

- **Start Calibration**
  Starts the pedal calibration process when clicked.

- **Calibration Table/Graph**
  Graphic representation of the calibration curve applied to the expression pedal.

- **Live Feedback Slider**
  (Hosted mode only)
  Live display of the incoming expression pedal data.

- **Smoothing**
  Adjusts the amount of smoothing placed on the expression pedal data. Moving the slider to the right applies more smoothing – moving the slider to the left applies less smoothing.

- **Reset Calibration Switch**
  Resets the pedal calibration table.

Calibration Process

After clicking the START CALIBRATION button, the calibration process begins. Fully rock an attached expression pedal back and forth for 5 seconds – the calibration table will update. The calibration process is now complete.

Expression Pedals

Only expression pedals will work with the SoftStep. Volume pedals do not work. This can get tricky because different companies use the word differently – volume pedals may be called expression pedals and vice versa.
4.5 Menu Bar Options

There are a number of useful functions and settings that can be accessed via the menu bar at the top of the screen (Mac OS) or at the top of the application window (Windows). Manage presets, copy/paste keys, update firmware, and more.

The following options are available in the Advanced Editor’s menu bar:

SoftStep Advanced Editor

This option is only available on Mac OS. Windows users can find the options listed below in the Help menu.

About SoftStep Advanced Editor

Displays information about the SoftStep Basic Editor, including the expected firmware version and the found firmware version.

- **Editor Version**: Displays the version number of the editor.
- **Expected FW**: Displays which firmware version is provided in this version of the editor. This is the version that will be loaded onto a connected SoftStep when a firmware update is initiated.
- **Found FW**: Displays the firmware version currently loaded on a connected SoftStep.

File

Export Preset

Exports the currently selected preset to an external file on the hard disk. Good for sending presets to a friend, transferring presets to a new computer, or creating a preset backup. The resulting .softsteppreset file can be imported to the Advanced Editor using the Import Preset function (also located in the File menu).

Import Preset

Imports a .softsteppreset file. Use this when restoring presets from backup, importing a preset from a friend, or importing presets from an older computer.

Import Hosted/Standalone Presets From v1.21

Allows importing presets from the previous SoftStep Editor – version 1.21.

1. Select “Import Hosted/Standalone Presets From v1.21”
2. Navigate to the old editor’s “Presets” folder
3. Click “Choose” – the importing process will automatically begin
4. Click the preset selection drop-down menu

When in Hosted mode, the Hosted mode presets from 1.21 will be imported – when in Standalone mode, the Standalone mode presets from 1.21 will be imported. This function does not currently allow for importing Standalone mode presets to Hosted mode (or vice versa).
Edit

Copy Preset
Copies the currently selected preset. Can be used later to paste over a preset or paste to a new preset.

⚠️ Note: Copy and Paste can be used to transfer presets from Hosted mode to Standalone mode (and vice versa).

Paste Preset
Pastes a copied preset to the currently selected preset. This option is only available if a preset has already been copied.

⚠️ Note: Copy and Paste can be used to transfer presets from Hosted mode to Standalone mode (and vice versa).

Paste Preset To New
Pastes a copied preset to a brand new preset. This option is only available if a preset has already been copied.

Copy Key
Copies the currently selected key’s settings (click a key box in the main window to select a key for copying).

Paste Key
Pastes the settings from a previously copied key to the currently selected key. This option is only available if a key has already been copied.

Hardware

Update/Reload Firmware
Manually initiates a firmware update/reinstallation.

Help

Documentation
Links to a downloadable version of this manual when selected. This will open a web browser tab.

Hide/Show Tool Tips
Selecting this option will toggle between hiding and showing the tooltip pop ups displayed when hovering the mouse cursor over an object.
4.6 Hosted vs. Standalone

The SoftStep can operate in two different modes — **Hosted** mode and **Standalone** mode. While functionality is generally the same between the two modes, there are some differences — each with their own benefits and drawbacks.

**Hosted Mode**

First and foremost, **Hosted** mode requires the SoftStep be connected to a computer with the Advanced Editor running.

When in Hosted mode, the SoftStep transmits its raw sensor data (as CC messages) to the SoftStep Editor. The editor then takes the raw data and processes it into the correct MIDI (as defined in the modlines), then outputs it over the virtual MIDI port, **SoftStep Share** (Mac only — Windows users should see the **SoftStep Share** section for more info on third-party alternatives).

**Standalone Mode**

When in Standalone mode, the SoftStep behaves like a “standard” MIDI controller — all MIDI data comes directly from the SoftStep. The editor does not need to be running in order to operate the SoftStep in Standalone mode.

**Differences between Hosted and Standalone mode**

**State Recall**

When in Hosted mode, state recall is available. This means that X/Y Increment, toggle, and LED states will be remembered when switching between presets. In Standalone mode state recall is not available for SoftStep 1 hardware — states will not be remembered when changing presets.

SoftStep 2 hardware *does* offer state recall when in Standalone mode.

**Live Editor Feedback**

When running the editor in Hosted mode the **modlines** provide live feedback — the **raw**, **result**, and **value** number boxes update in real time to show what is going on in the modlines. This behavior does not occur when in Standalone mode.

**Source List**

Standalone mode does not support the full list of **sources** and **message types** that Hosted mode does. In Standalone mode, the sources list does not include MIDI A-H, Top, Bottom, the trigger latch sources, or most Nav sources. Message types not included in Standalone mode are OSC, Garageband, Aftertouch, Poly Aftertouch, Y Inc Set, or X Inc Set.

A complete list of sources and messages types can be found in the **Sources** and **Message Types** section, respectively.
Output Port

One big difference between Hosted and Standalone mode is the output port that should be used. **SSCOM Port 1** should be used for Standalone mode (data coming directly from the SoftStep), and **SoftStep Share** should be used for Hosted mode (data coming from the editor).

⚠️ **Note:** SoftStep Share is a virtual MIDI port built into the Mac OS version of the Advanced Editor. Windows users will need to install and use a third-party MIDI bus of their choice, like MIDI Yoke or LoopBe. More information can be found in the [SoftStep Share](#) section.

Adjacent Key Lockout

The **Adjacent Key Lockout** key safety setting is only available in Hosted mode.

Display Mode 1-128 vs 0-127

The **Display Mode** setting is only available in Standalone mode. The same effect can be created in Hosted mode using some fancy modline work.

Disabling Scene Changing

The **Scene Changing On/Off** setting is only available in Standalone mode. The same effect can be achieved in Hosted mode by having only one scene in the setlist.

4.7 SoftStep Ports

When a SoftStep is connected to a computer, two virtual MIDI “ports” (or “busses”) are created – **SSCOM Port 1** and **SSCOM Port 2**. They are the “portal” to communicating with a connected SoftStep. The ports allow for bi-directional communication between the computer and the SoftStep (and MIDI Expander if one is connected), and should appear in any MIDI-capable application when a SoftStep is connected.

Understanding what each port is for and how they work is crucial to mastering the SoftStep hardware and software.

**SSCOM Port 1 vs. SSCOM Port 2**

**SSCOM Port 1** is used to receive data from (and send data to) the SoftStep itself.

In Standalone mode, applications should listen to this port to receive MIDI coming from the SoftStep. This is also the port that data should be sent to for controlling the **SoftStep LEDs, display, and presets**.

**SSCOM Port 2** is used to receive data from (and send data to) an attached **MIDI Expander**. MIDI sent from an external device to the Expander’s MIDI In will enter a computer via SSCOM Port 2. Any MIDI sent to SSCOM Port 2 will be sent out of the Expander’s MIDI Out.
SSCOM Port 1 in Hosted Mode

When operating in Hosted mode, SSCOM Port 1 behaves differently than it does in Standalone mode.

In Hosted mode, SSCOM Port 1 transmits the SoftStep’s raw sensor data to the editor, which then processes the data into the correct MIDI messages and outputs it.

⚠️ Note: The SoftStep’s raw data appears as a series of MIDI CC messages — CCs 40-83 (four per key, including the Nav Pad). If “weird” CC messages appear when using the SoftStep in Hosted mode, SSCOM Port 1 will need to be disabled or filtered out in the software being used. Some applications allow for this (Ableton Live, Traktor, or Max/MSP, for example) while others do not and are just listening to all MIDI ports at all times (Logic and MainStage, for example). The latter can be quite tricky when trying to MIDI map.

SoftStep Share

SoftStep Share is a virtual MIDI port provided with the Mac OS version of the Advanced Editor. It is used as an inter-application MIDI bus — it routes MIDI from the editor to other applications.

SoftStep Share is only available (and only necessary) when in Hosted mode – audio/MIDI applications should listen to this port to receive MIDI (when in Hosted mode).

Using SoftStep Share is simple – it is automatically available after opening the Advanced Editor, and using it is just a matter of selecting “SoftStep Share” as the Output Port of the modlines.

Windows Users

The Windows version of the Advanced Editor does not come with a built-in virtual MIDI port – users will have to download and install a third-party MIDI bus of their choice.

KMI recommends using MIDI Yoke (http://www.midiox.com/myoke.htm) or LoopBe (http://www.nerds.de/en/loopbe1.html). Once installed, “Out to MIDI Yoke: [1-8]” or “LoopBe” (depending on which one was installed) will automatically appear in the Output Port drop-down in the modlines.

⚠️ Note: It may look like MIDI Yoke is out of date, but it will still install and run just fine on computers running Windows 7 and Windows 8. Be aware that the UAC (User Account Control) will likely need to be disabled for the installation to work.
Appendix
5.0 Appendix

5.1 Sources

All available sources and what they do:

**Pressure Live**

Outputs the amount of pressure currently being applied to the key. The value will drop to 0 when the key is released.

- Range: 0-127 (no pressure to full pressure)

**X Live**

Outputs the amount of left-to-right (x-axis) pressure currently being applied to the key. The value will return to center (63) when the key is released.

- Range: 0-127 (left to right)

**Y Live**

Outputs the amount of bottom-to-top pressure (y-axis) currently being applied to the key. The value will return to center (63) when the key is released.

- Range: 0-127 (bottom to top)

**Pressure Latch**

A latching version of the **Pressure Live** source – the value will stay wherever it is when the key is released.

- Range: 0-127

**X Latch**

A latching version of the **X Live** source – the value will stay wherever it is when the key is released.

- Range: 0-127

**Y Latch**

A latching version of the **Y Live** source – the value will stay wherever it is when the key is released.

- Range: 0-127
**X Increment**
Similar to a horizontal slider/fader. Applying pressure to the right side of the key will output an incrementing value, while pressure to the left side will output a decrementing value.

The Speed at which the source increments/decrements can be modified using the **X Inc Speed** options in the **Keys** tab of the **Settings** window.

- Range: 0-127

**Y Increment**
Similar to a vertical slider/fader. Applying pressure to the upper half of the key will output an incrementing value, while pressure to the bottom half will output a decrementing value.

The speed at which the source increments/decrements can be modified using the **Y Inc Speed** options in the **Keys** tab of the **Settings** window.

- Range: 0-127

**Foot On**
Outputs a 127 when the key is pressed and a 0 when the key is released.

**Foot Off**
The inverse of **Foot On** – outputs a 0 when the key is pressed and a 127 when the key is released.

This could also be created using Foot On, setting the gain to -1, and adding an offset of 127 – but hey, this is faster and with less thinking involved.

**Top**
(Hosted mode only)
Outputs a 127 when the top half of the key is pressed and a 0 when the key is released.

**Bottom**
(Hosted mode only)
Outputs a 127 when the bottom half of the key is pressed and a 0 when the key is released.

**Fast Trig**
(Hosted mode only)
Pressing the key immediately outputs a 127 followed by a 0 (100ms later).

**Db1 Trig**
Two quick presses of the key will output a 127 followed by a 0 (100ms later).
Long Trig
Pressing and holding the key for 1 second will output a 127 followed by a 0 (100ms later).

Off Trig
(Hosted mode only)
Outputs a 127 followed by a 0 (100ms later) when the key is released.

Fast Trig Latch
(Hosted mode only)
Immediately outputs a 127 when the key is pressed. Does not go back to 0.

Dbl Trig Latch
(Hosted mode only)
Two quick presses of the key will output a 127. Does not go back to 0.

Long Trig Latch
(Hosted mode only)
Pressing and holding the key for 1 second will output a 127. Does not go back to 0.

Pedal
If an expression pedal is connected, this source will output the current value coming from the pedal.
• Range: 0-127

Init
(Standalone mode only)
Outputs a 127 whenever the current preset is loaded. Useful for initializing values whenever a specific preset is loaded. Use the min and max options (or offset) in the modlines to send a specific value.

Nav Yx10 & Key
Works in tandem with the Nav Pad. The Nav Pad must also be in Program Change mode or using the Nav Y Decade source.
The Nav Pad’s current counter value is multiplied by 10 to get a “decade” – e.g. 20s, 30s, 40s, etc., then the key number (this source is placed on) is added to the value when pressed.
• **Example**: Place this source on key 2. Press up on the Nav Pad 3 times — this increments the counter to 3 — then step on key 2. The resulting value will be 32, or $(3 \times 10) + 2$.

**Key 0-9 Pressed**

Outputs a 127 when the corresponding key is pressed — e.g. Key 4 Pressed will output a 127 whenever key 4 is pressed. This source is great for turning other keys’ LEDs on/off.

**Other Key Pressed**

Placing this on a key will output a 127 when a different key is pressed, and output a 0 when the key this is assigned to is pressed. Example: place this on key 2 — it will output a 0 when key 2 is pressed and output a 127 when any other key is pressed.

**Modline 1-6 Output**

Uses the final output value from another modline (1-6) and sends it through the modline this source is assigned to. Great if any extra data processing for more complex setups is needed.

**MIDI A-H**

(Hosted mode only)

Receives the values from the MIDI inputs assigned in the **Settings** window and passes them through the modline.

**OSC A-H**

(Hosted mode only)

Receives the values from the OSC inputs assigned in the **Settings** window and passes them through the modline.
Nav Pad Sources

The following sources are exclusive to the Nav Pad:

**Nav Y**

(Hosted mode only)
Pressing up on the Nav Pad (the north key) increments the Nav Pad's counter – pressing down on the Nav Pad (the south key) decrements the counter.

**Nav Y Decade**

(Hosted mode only)
This is the Nav Pad's Program Change mode wrapped up into source form. It works in tandem with other keys using the Nav Yx10 & Key source.
Pressing up/down on the Nav Pad increments/decrements through the Nav Pad's counter and multiplies the value by 10. This results in a “decade” value (e.g. 20s, 30s, 40s, 50s, etc.). Stepping on a key using the Nav Yx10 & Key will then add that key number to the decade value.

The decades range can be adjusted using the min and max options in the Nav Pad counter.

**Nav Y Inc-Dec**

The Nav pad version of the Y Increment source. Pressing up on the Nav Pad (the north key) increments the value, pressing down on the Nav Pad (the south key) decrements the value.
- Range: 0-127

**Nav N Foot On**

(Hosted mode only)
One of the Nav Pad versions of the Foot On source. Outputs a 127 when pressing the north key (up) on the Nav Pad, outputs a 0 when released.

**Nav S Foot On**

(Hosted mode only)
One of the Nav Pad versions of the Foot On source. Outputs a 127 when pressing the south key (down) on the Nav Pad, outputs a 0 when released.

**Nav N Foot Off**

(Hosted mode only)
One of the Nav Pad versions of the Foot Off source. Outputs a 0 when pressing the north key (up) on the Nav Pad, outputs a 127 when released.
Nav S Foot Off
(Hosted mode only)
One of the Nav Pad versions of the Foot Off source. Outputs a 0 when pressing the south key (down) on the Nav pad, outputs a 127 when released.

Nav N Trig
(Hosted mode only)
Outputs a 127 when the north key on the Nav Pad is pressed and held down for 500ms, then outputs a 0 (100ms later).

Nav N Trig Fast
(Hosted mode only)
The same as the Fast Trig source. Applies to the north key on the Nav Pad.

Nav N Trig Dbl
(Hosted mode only)
The same as the Dbl Trig source. Applies to the north key on the Nav Pad.

Nav N Trig Long
(Hosted mode only)
The same as the Long Trig source. Applies to the north key on the Nav Pad.

Nav S Trig
(Hosted mode only)
Outputs a 127 when the south key on the Nav Pad is pressed and held down for 500ms, then outputs a 0 (100ms later).

Nav S Trig Fast
(Hosted mode only)
The same as the Fast Trig source. Applies to the south key on the Nav Pad.

Nav S Trig Dbl
(Hosted mode only)
The same as the Dbl Trig source. Applies to the south key on the Nav Pad.

Nav S Trig Long
(Hosted mode only)
The same as the Long Trig source. Applies to the south key on the Nav Pad.
5.2 Message Types (Advanced Editor)

Message Types select what kind of MIDI message the modline will output (there are also a couple of other message types, but MIDI is the most common). The following message types are available in the Advanced Editor:

---

**None**

No message will be output. Good for modlines that are only controlling LED behavior or being further processed using one of the **Modline 1-6 Output** sources.

---

**Note Set**

Outputs a MIDI note with a specified velocity. A positive value will send a note on message, a value of 0 will send a note off message. The following options are available when **Note Set** is selected:

- **Note**
  - Sets the note number to be output.

- **Vel**
  - Sets the velocity value to be output with the note on messages.

- **Ch**
  - Sets the MIDI channel to output the note messages on.

---

**Note Live**

Outputs MIDI notes with a specified velocity. The note number is determined by the values coming through the modline. The following options are available when **Note Live** is selected:

- **Vel**
  - Sets the velocity value to be output with the note on messages.

- **Ch**
  - Sets the MIDI channel to output the note messages on.

---

**CC**

Outputs values on a specified Control Change (CC) number. The following options are available when **CC** is selected:

- **CC#**
  - Sets the CC number to send the messages on.
Ch
Sets the MIDI channel to output the CC messages on.

Bank
Outputs values as MIDI bank select messages. The following options are available when Bank is selected:

   MSB
   Sets the MSB of the bank message.

   Ch
   Sets the MIDI channel to output the bank select messages on.

⚠️ Note: Bank Select messages are 14-bit resolution (a range of 0-16383), as opposed to the standard 7-bit MIDI message (range 0-127). This is accomplished by using two separate messages: a MSB (most significant bit) and an LSB (least significant bit). With SoftStep, values passing through the modline will set the LSB of the bank message – the MSB must be fixed at a specified value (using the MSB option).

Program
Outputs values as MIDI program change messages. The following options are available when Program is selected:

   Ch
   Sets the MIDI channel to output the program change messages on.

Pitch Bend
Outputs values as MIDI pitch bend messages.

- 0 = full bend down
- 63 = center (no bend)
- 127 = full bend up

The following options are available when Pitch Bend is selected:

   Ch
   Sets the MIDI channel to output the pitch bend messages on.

MMC
Used to send MIDI Machine Control (MMC) messages. The following options are available when MMC is selected:
ID
Sets the device ID number for the MMC message. Each MMC-capable device should have a unique ID number (most devices/software allow the user to set the ID number in case of conflicts).

Function
Sets the MMC function/command that should be sent. The following are available with SoftStep:
- Stop
- Play
- Deferred Play
- Fast Forward
- Rewind
- Punch In
- Punch Out
- Pause

OSC
(Hosted mode only)
Outputs values as an OSC message with a specified prefix. OSC settings such as input port, output port, output IP address can be set in the OSC tab of the Settings window. The following options are available when OSC is selected:

Output Prefix
Sets the prefix to output with the OSC message. A prefix typically begins with a “/” character, e.g. /softstep or /controller. Defaults to “/softstep” (no quotes) when no prefix is specified.

Aftertouch
(Hosted mode only)
Outputs values as MIDI aftertouch messages. The following options are available when Aftertouch is selected:

Ch
Sets the MIDI channel to output the aftertouch messages on.

Poly Aftertouch
(Hosted mode only)
Outputs values as MIDI polyphonic aftertouch messages. The following options are available when **Poly Aftertouch** is selected:

**Note**

Sets the note number to associate with the poly aftertouch message.

**Ch**

Sets the MIDI channel to output the poly aftertouch messages on.

**Y Inc Set**

(Hosted mode only)

Sets a key’s Y Increment value. Any value going through the modline will instantly set the current key's Y Increment value. Useful for initializing Y Increment values from other keys or preset changes.

**X Inc Set**

(Hosted mode only)

Sets a key’s X Increment value. Any value going through the modline will instantly set the current key’s X Increment value. Useful for initializing X Increment values from other keys or preset changes.
5.3 Tables

All available SoftStep tables:

**Linear**
A 1:1, linear table. Values passing through will not be modified in any way.

**Sine**
Applies a sine curve to incoming values.

**Cosine**
Applies a cosine curve to incoming values.

**Exponential**
An exponential table. Lower values rise slowly – higher values rise quickly.

**Logarithmic**
A logarithmic table. Lower values rise quickly, higher values rise slowly.

**Toggle**
Alternates between a high (127) and low (0) value whenever a 0 to positive value transition (e.g. 0 to 127) passes through the modline. Using the **Foot On** source with the **Toggle** table makes a great toggle switch!

**Counter Inc**
(Hosted mode only)
Increments the key’s counter and outputs the value when a 0 to positive value transition (e.g. 0 to 127) is sent through the modline.

**Counter Dec**
(Hosted mode only)
Decrements the key’s counter and outputs the value when a 0 to positive value transition (e.g. 0 to 127) is sent through the modline.

**Counter Set**
(Hosted mode only)
Immediately sets (and outputs) the key’s counter to the value coming through the modline.
5.4 Inits

Inits (short for “Initializations”) allow for initializing parameters/modlines when a preset is loaded. Inits consist of two parts: a mode and a value.

**Mode**

The mode defines how the init behaves. The following options are available:

- **None**
  
  No initialization value will be output.

- **Once**
  (Hosted mode only)
  
  Outputs the init value the first time the preset this is placed on is loaded. Switching to this preset again will not output the init value.

  This applies per session – “Once” will only reset by quitting the Advanced Editor and reopening it.

- **Always**
  
  Outputs the init value every time the preset this is placed on is loaded.

**Value**

Sets the value to output when the init is triggered. This value will be passed through the modline it is placed on.

5.5 Display Modes

Display modes are used to define how the SoftStep’s display behaves when interacting with the keys. The following display mode options are available in the SoftStep Advanced Editor:

- **None**

  Has no effect on the SoftStep display. Stepping on a key with None selected will show the current preset name.

- **Always**

  Displays the key name whenever the key is pressed. The key prefix and parameter value are not used in this mode.
Once
(Hosted mode only)
The key name will be displayed as soon as the key is pressed for the first time, after a brief period the prefix and parameter value will be displayed. Any subsequent key presses will display the prefix and parameter value.

Initial/Return
The key name will be displayed as soon as the key is pressed. After a brief period the prefix and parameter value will be displayed.

Immed Param
Displays the key's prefix and parameter value whenever the key is pressed.

5.6 LED Modes
LED modes define how the SoftStep’s LEDs should behave. Tell them when to turn on, when to turn off, and more. Each of the following options are available in the Advanced Editor for both the green and red LEDs:

None
Has no effect on the LED state. If the LED is currently on, it will stay on – if it’s off, it will stay off.

True
The LED will turn on when the modline value is 1 or greater. It will turn off when the modline value is equal to 0.

False
The LED will turn on when the modline value is equal to 0. The LED will turn on when the modline value is 1 or greater.

Flash True
The LED will continuously flash when the modline value is 1 or greater. It will turn off when the modline value is equal to 0.

Flash False
The LED will continuously flash when the modline is equal to 0. It will turn off when the modline value is 1 or greater.
Flash Fast True
The LED will continuously flash quickly when the modline value is 1 or greater. It will turn off when the modline value is equal to 0.

Flash Fast False
The LED will continuously flash quickly when the modline value is equal to 0. It will turn off when the modline value is 1 or greater.

Blink True
The LED will blink once when the modline value is 1 or greater. Nothing will happen when the modline value is equal to 0.

Blink False
The LED will blink once when the modline value is equal to 0. Nothing will happen when the modline value is 1 or greater.

Off
Turns the LED off when a value of 1 or greater is received

5.7 External Control Of SoftStep
The SoftStep can control a wide variety of MIDI software and hardware, but it can also be controlled from an external source via USB or MIDI Expander.

5.7.1 Controlling SoftStep LEDs
The SoftStep’s LEDs can be controlled from an external software or hardware source using CC messages. Each numbered key has a red and green LED that respond to the following messages:

Red LEDs
CCs 20-29 control the red LEDs on keys 0-9 (one CC per key).
CCs accompanied with a value of:
• 0 = LED Off
• 1 = LED On
• 2 = LED Fast Flash
• 3 = LED Slow Flash
Green LEDs

CCs 110-119 control the green LEDs on keys 0-9 (one CC per key).

CCs accompanied with a value of:

- 0 = LED Off
- 1 = LED On
- 2 = LED Fast Flash
- 3 = LED Slow Flash

⚠️ Note: When sending MIDI via USB, CCs should be sent to SSCOM Port 1.

5.7.2 Controlling SoftStep Display

In addition to the key LEDs, the four-character display on the SoftStep can also be controlled via external software or hardware using CC messages.

The four characters on the display are addressed using four CC messages:

- CC 50 = first character
- CC 51 = second character
- CC 52 = third character
- CC 53 = fourth character

Each CC should be sent with a value between 48 and 122. These values correspond to the following:

- 48-57 = Numbers 0-9
- 65-90 = Capital letters A-Z
- 97-122 = Lowercase letters a-z
- 58-64 & 91-96 = various symbols/characters

So, for example, to make the third character on the display show the number “3”, send CC 52 with a value of 51.

⚠️ Note: When sending MIDI to the SoftStep via USB, CCs should be sent to SSCOM Port 1.

5.7.3 Changing Presets With Program Changes

When in Standalone mode, changing SoftStep presets via external software/hardware is possible using program change messages. Program changes 1 through 16 sent to SSCOM Port 1 will select the corresponding preset in the setlist – e.g. sending program change 7 will load the seventh preset in the setlist.
5.7.4 Using The MIDI Expander

It is possible to control the SoftStep LEDs, display, and presets via input to an attached MIDI Expander. When sending CCs and program change messages to control the SoftStep via the Expander, the messages must be sent on MIDI channel 16 — any other channels will be ignored and handled normally (see SSCOM Port 2 section for more info on "normal").
5.8 Factory Presets Guide (Advanced Editor)

All factory presets are set to output over both USB and MIDI Expander (if one is connected) on MIDI Channel 1.

Program Change (PRGM)

Each key outputs a program change message. The up and down keys on the Nav Pad increment/decrement by “decades” (increments of 10) – stepping on a key fills in the final value (0-9) and outputs the program change message. This allows access to all program change messages, 0-127.

Toggles (TOGL)

Each key outputs a toggling CC message (CCs 20-29). Step on a key and it toggles on (outputs a 127), step on that key again and it toggles off (outputs a 0). Each key’s green LED provides visual feedback of the current toggle state – it lights up green when on and turns off when off.
Notes (NOTE)

Each key outputs a MIDI note (notes 60-69). Step on a key to send a note on message, release the key to send a note off message. Each key’s green LED will light up while the note is activated (key is pressed) and turn off when the note turns off (key is released).

Pressure Live (PRES)

Each key outputs a key’s pressure as a CC message (CCs 110-119). Placing more pressure on a key makes the value go higher, less pressure makes the value go lower.
ElevenRack Control (11RK)

This preset works with an Avid Eleven Rack processor. A MIDI Expander is required to connect to the Eleven Rack. The top row of keys turn effect on and off – the bottom row modulates the effects' parameters.

Line6 Pad Control (POD)

This scene works with most Line6 processors, including the Pod. A MIDI Expander is required to connect to the Pod. The top row of keys turn effects on and off – the bottom row modulates the effects’ parameters.
LIVE (Ableton Live Control)

This preset works with our custom Ableton Live script (provided in the “Extras” folder of the SoftStep 2 software package). Control the transport with the top row of keys – control track volumes with the bottom row. Up/Down on the Nav Pad controls the master volume fader.
5.9 MIDI Note Naming Reference

MIDI notes are numbers between 0 and 127, while music notes are lettered A through G# (in traditional Western notation) – there must be a way to convert between the two. There are actually multiple standards for naming MIDI note numbers, which can make things tricky.

Keith McMillen Instruments follows the C3=60 standard for naming/numbering notes. Below is a chart that can help with converting note numbers to note names and vice versa.

<table>
<thead>
<tr>
<th>Octave</th>
<th>Note Names / Numbers  (C3=60)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>C</td>
</tr>
<tr>
<td>-2</td>
<td>0</td>
</tr>
<tr>
<td>-1</td>
<td>12</td>
</tr>
<tr>
<td>0</td>
<td>24</td>
</tr>
<tr>
<td>1</td>
<td>36</td>
</tr>
<tr>
<td>2</td>
<td>48</td>
</tr>
<tr>
<td>3</td>
<td>60</td>
</tr>
<tr>
<td>4</td>
<td>72</td>
</tr>
<tr>
<td>5</td>
<td>84</td>
</tr>
<tr>
<td>6</td>
<td>96</td>
</tr>
<tr>
<td>7</td>
<td>108</td>
</tr>
<tr>
<td>8</td>
<td>120</td>
</tr>
</tbody>
</table>

⚠️ Note: Other software/hardware may follow the C4=60 naming scheme (or even C5=60), which can lead to some confusion when MIDI mapping or setting up SoftStep. All MIDI notes will appear to be an octave off (by name), but in MIDI-land they have the same note number – which is all that matters.
5.10 Changes From SoftStep v1.21

General

Scenes are now “Presets”

Formerly the Advanced Editor could save an individual key’s settings as a “preset”, and a “scene” referred to the settings for all keys (a “meta-preset” per se) – similar to Ableton’s clips and scenes paradigm (a single clip vs. a collection of clips). Key presets have been gone for a long time (as of version 1.2), and now that there are no longer multiple levels of presets the term “scene” is not needed.

Basic Editor

Changes specific to the Basic Editor.

Easy Editor is now Basic Editor

Name change!

Basic Editor now allows multiple presets

Formerly, the SoftStep Easy Editor only allowed for a single preset. The Basic Editor now offers ten presets.

Source options are now different

The Basic Editor now allows each key to send one of the following: MIDI Note, Pressure CC, Toggle CC, X/Y, Y Increment, Program Change.

Sources have expanded options

- MIDI Note now offers a toggling option – the first press turns the note on, the next press turns the note off.
- Pressure now offers optional smoothing.
- Toggle has settable low and high values.
- X/Y offers optional latching (values stay where they are when the key is released), and the ability to turn either the X or Y CC off (in case both are a bit overkill).
- The Program Change option allows sending an additional Bank Select message along with the Program Change message.

Factory presets from Advanced Editor can be used

The Basic Editor now allows using a factory preset from the Advanced Editor in place of a Basic Editor preset. Only the factory presets that cannot be created with the Basic Editor are available. The factory presets Toggles, Notes, and Pressure are not available because they are easily recreated in the Basic Editor (and are already available as Basic Editor factory presets).
Advanced Editor

Some changes specific to the Advanced Editor.

**SoftStep Editor is now Advanced Editor**

Name change!

**Foot On & Off, Top & Bottom, Triggers now send 127 instead of 1**

The Foot On, Foot Off, Top, Bottom, and all trigger sources used to output a value of 1 when engaged. In the MIDI world, the need to output a value of 127 is much more common than needing to output a 1 – so the above sources now output a 127.

If the old behavior is desired, set the modline’s `max` option to 1 – this will limit the 127 to 1.

**Toggle table now toggles between 127 and 0**

In earlier SoftStep Editor versions the Toggle table alternated between values of 1 and 0. Similar to the Foot On source, the need to output a value of 127 is much more common than needing to output a 1 – thus, the Toggle table now alternates between 127 and 0.

If the old toggle behavior is desired, set the modline’s `max` option to 1 – this will limit the 127 to 1.

**Removed Toggle 127 table**

The normal Toggle table inherited Toggle 127’s behavior, so the Toggle 127 table is no longer necessary.
5.11 Troubleshooting

Here are some suggestions that can potentially solve problems that may pop up while using the SoftStep.

**Firmware Updating Troubles On Windows**

Some Windows users may experience problems when trying to update their firmware via the editors. If this is the case we have provided a separate utility, FirmwareUpdater.exe, that will automatically take care of it. To use it, do the following:

1. Close all audio/MIDI applications.
2. Connect the SoftStep to the computer.
3. In a Windows Explorer window, navigate to either the Basic Editor or Advanced Editor folder — it doesn't matter which one, the updater utility is in both.
4. Double-click the FirmwareUpdater.exe file
5. Wait for the firmware update to complete. This may take a little while, so please be patient. The updater utility will indicate that it is sending firmware and the SoftStep’s display should go blank.
6. Once done, close the FirmwareUpdater window.

Once the firmware has been successfully updated, open one of the editors and get to work. The SoftStep should work fine.

**Connectivity Issues**

If the SoftStep is failing to connect to a computer, there are a number of things that can potentially solve the problem:

**Check that you’re using the correct USB port on the SoftStep**

There are two USB connectors on the SoftStep hardware — the main USB port (the USB B connector labeled “USB”) and the Expander port (the mini USB connector labeled “Expand”). When connecting to a computer, always use the main USB port. The Expand port will not work when connected to a computer, it is exclusively for using with the KMI MIDI Expander.

**Try a new USB cable**

One of the first (yet most often overlooked) things to try is a different USB cable, preferably one that is known to work well. When a cable goes bad it can lead to all sorts of odd behavior, or no behavior at all.

**Try plugging into a different USB port**

It’s possible that trying a different USB port on the computer may lead to a proper connection. While extremely rare, we have come across some USB ports that just don’t seem to like the SoftStep.
Do not use an unpowered USB hub

Unpowered USB hubs may not be able to provide enough power to the SoftStep, leading to connectivity issues. Unpowered hubs typically divide the power coming from the computer’s USB port and split it into each of the hub’s ports — providing less power than if the SoftStep were to be directly connected to the computer’s USB port.

If a USB hub is absolutely necessary, always use a powered hub.

Try without a USB hub

If experiencing connectivity issues while using a USB hub, try without the hub and plug directly into the computer’s USB port. This may potentially lead to a proper connection.

Be aware of bugs native to the operating system being used

While it is indeed possible the SoftStep may be the source of issues, sometimes the cause is actually due to the operating system itself. Always be aware of these issues, like the Mac OS CoreMIDI bug or the Windows class-compliant device limitation.

Connect to a different computer

If the SoftStep is not making a connection to the computer at all, it is recommended to try connecting it to a different computer. If it works on the new computer, try the original one again. In some circumstances we have seen this solve connection issues.

Mac OS CoreMIDI “bug”

There is an interesting (potential) bug in CoreMIDI on Mac OS that can lead to some connectivity issues — not just with SoftStep, but with any class-compliant MIDI device.

Upon connecting the SoftStep (or any class-compliant MIDI device) for the first time since powering up the computer, the SoftStep will make a proper connection to the computer but will not refresh/update the MIDI device list.

The effect of this is that any audio/MIDI applications that are already open (like the SoftStep editors, Ableton, Logic, etc.) will not detect the SoftStep, even though it’s properly connected to the computer. The only way to get the MIDI device list to refresh is to unplug then reconnect the controller, or to manually refresh the MIDI devices by rescanning MIDI in the Audio MIDI Setup application (located in /Applications/Utilities).

What’s interesting is that this behavior does not occur if it is the first time the controller has ever been connected to the computer. It seems that when the MIDI device is created in Audio MIDI Setup the device list gets refreshed, but if the device already exists in Audio MIDI Setup the list does not refresh.

Whether or not this behavior is intentional and expected, it is something to be aware of. We have noticed it on Mac OS 10.6 through 10.9. The one thing to do to minimize the chances of running into this “bug” is...
After powering up the computer, always connect the SoftStep to the computer before opening any applications.

“Okay, so how do I fix it if this does happen?” Well, if you do run into this problem, there are a number of ways to fix it:

- Unplug the SoftStep and plug it back in.
- Open Audio MIDI Setup and click the “Rescan MIDI” button in the MIDI window.
- Open another audio/MIDI application.

All three of the above methods refresh the MIDI device list, which should lead to proper “in-app” connections.

**Windows Class-Compliant Device Limitation**

Windows XP, Windows Vista, Windows 7, and Windows 8 do not allow a class-compliant MIDI device to be connected to more than a single application at a time. As a class-compliant MIDI controller, this applies to the SoftStep.

The result of this is that if you have two or more audio/MIDI applications open at the same time (the Advanced Editor and Ableton Live, for example), only one of them will be able to connect to the SoftStep. Because of this it is highly recommended to never edit the SoftStep with other audio applications open – it could lead to connectivity issues, and a very confusing, frustrating experience.

This does not apply solely to KMI products, this will have an effect with every class-compliant MIDI device.
5.12 FAQ

How do I contact KMI support for questions about my SoftStep?

Support can be reached by submitting a support ticket at the following website: http://www.keithmcmillen.com/support

Before submitting a ticket it is definitely a good idea to read through the rest of the FAQ section to make sure your question hasn’t already been answered.

What information should I include in a support request/question?

Providing helpful, useful information about any issues is an extremely important part of getting a helpful, useful response back. When submitting a support ticket, it is wise to include the following information:

- Your computer’s operating system.
- The software/hardware being used with your SoftStep.
- Are you running in Hosted mode or Standalone mode?
- A description of what you’re trying to accomplish. Your goal.
- A description of the problem you’re experiencing.
- Any steps you have taken to fix the problem (you have tried, right?).
- Any special/extra information about your setup – e.g. using a USB hub.

Failing to include the above will generally result in an email asking you to provide the above – delaying the actual solution to the issue you’re experiencing.

Will installing the SoftStep 2 software overwrite the SoftStep 1 software?

No. Installing SoftStep 2 will not overwrite the old editor. The act of “installing” is really just copying a folder onto your hard drive. The SoftStep 1.21 and SoftStep 2 folders are named differently and do not affect one another – they exist separately and both can still be used. You’ll have to change firmwares when switching back and forth, but it will still work (note that SoftStep 2 hardware won’t work with the old 1.21 editor).

Can I use two SoftSteps at the same time?

Hosted mode is limited to a single SoftStep at a time, but a lot of SoftSteps can be used simultaneously if they’re running in Standalone mode. The USB spec states “up to 127 devices, including hub devices if present, may be connected to a single host controller”. As a class-compliant USB MIDI device, this applies to the SoftStep.

⚠️ Note: Only a single SoftStep can be edited at a time using the editors.
How do I update/reload my firmware?

There are a few ways firmware can be updated on a SoftStep: automatically by the Basic and Advanced editors, manually with the editors, or manually without the use of the editors.

Automatically

If a SoftStep is connected to an editor with a differing firmware version (e.g. you just downloaded a new editor update and fired it up), the editor should automatically prompt you to update the firmware. Just click the UPDATE button to initiate the firmware installation.

Manually (with Advanced/Basic Editor)

The SoftStep Basic and Advanced editors can be used to manually initiate a firmware update/reinstall — just do the following:

1. Connect the SoftStep to a computer.
2. Open either the Basic Editor or Advanced Editor.
3. Go up to the Hardware menu and select “Update/Reload Firmware”. This option will only be selectable if a SoftStep has successfully connected to the editor.
4. In the prompt that appears, click the UPDATE button — this will initiate the firmware update process.
5. Wait for the firmware update to complete — a progress bar will show how much of the update has completed.
6. If you have any custom presets, resend them to the SoftStep — reinstalling or updating firmware will revert all presets to their factory state.

Manually (without Advanced/Basic Editor)

Typically the SoftStep editors will do just fine updating firmware on your board, but in some cases it may be necessary to manually update the firmware (like if the controller is not connecting to the editor).

The SoftStep firmware can be loaded/installed manually using any application capable of sending SysEx files to connected MIDI devices. We recommend SysEx Librarian for Mac (http://www.snoize.com/SysExLibrarian/), and SysEx Box for Windows (http://miostools.midibox.org/) — though there are certainly other capable third-party options available.

To update your firmware...

Mac

1. If you have not already, download and install SysEx Librarian from http://www.snoize.com/SysExLibrarian/
2. Download or locate the firmware file you would like to install. Zips of the current version and past versions can be downloaded here: http://files.keithmcmillen.com/downloads/softstep/sysex_files/
3. Plug in your SoftStep and open SysEx Librarian.
4. Click “Add...” in the lower-left corner of the screen. When the browser window opens, navigate to the firmware file (generally named to the effect of “Softstep-88.syx”) then click “Open”.
5. Select Port 1 (for “SSCOM Port 1”) from the drop down menu labeled “Destination”.
6. Select the firmware file in SysEx Librarian’s main window – it should highlight blue.
7. Click the “Play” button in the top-left corner of SysEx Librarian to begin the firmware installation. A progress bar will appear indicating how far along the update process is. The SoftStep’s display will go blank and look non-responsive while the update is taking place – this is okay and to be expected.
8. Once done, wait for the SoftStep to boot back up. This may take a few seconds, so please be patient.

Windows
1. If you have not already, download and install SysEx Box from http://miostools.midibox.org/
2. Download or locate the firmware file you would like to install. Zips of the current version and past versions can be downloaded here: http://files.keithmcmillen.com/downloads/softstep/sysex_files/
3. Make sure all audio/MIDI applications are closed.
4. Plug in your SoftStep and open SysEx Box.
5. Select SSCOM Port 1 in the “MIDI IN Port” and “MIDI OUT Port” drop-down menus. “SSCOM Port 1” may show up as “USB Audio Device (1)” on Windows XP.
6. Click “Open Sysex File”. When the browser window opens, navigate to the firmware file you want to send to the SoftStep, then click “Open”.
7. Click the “Send Sysex” button. The firmware update should begin. The SoftStep’s display will go blank and look non-responsive while the update is taking place – this is okay and to be expected.
8. Once done, wait for the SoftStep to boot back up. This may take a few seconds, so please be patient.

Does reloading or updating firmware reset my presets?
Yes. A firmware update or reinstall will reset the SoftStep’s onboard presets to factory settings. If you have any custom presets you will need to resend them to the SoftStep using one of the editors.

Is there a way to reset the SoftStep back to factory settings?
Yes, it is possible to reset both the SoftStep to factory settings. All that needs to be done is a firmware reinstall (we just went over this in the previous question) – this will revert everything to factory settings and presets. Instructions on how to reinstall firmware can be found here.
How do I find out what firmware is installed on my SoftStep? Also, what firmware will the editor install?

Finding out what firmware version is installed on the SoftStep is simple. When a SoftStep is powered up it will briefly display the firmware version that is currently installed on it. Just plug in the SoftStep and look at the first displayed number – that’s the firmware version. This information is also available via the SoftStep editors.

To find out what firmware version is included in the Basic or Advanced editors, do the following:

1. Open the editor you’re curious about.
2. **Mac**: Go up to the “SoftStep Advanced/Basic Editor” option in the menu bar and select “About SoftStep Advanced/Basic Editor”. **Windows**: Go up to the Help menu in the menu bar and select “About SoftStep Advanced/Basic Editor”. The main window will now display information about the editor and connected SoftStep (if one is connected).

The *Expected FW* field lists the firmware version included with the editor – this is what will be installed if a firmware update is initiated. The *Found FW* field lists the firmware version currently installed on the connected SoftStep. The *Editor Version* lists the version number of the editor itself (not firmware related).

Can I save Hosted mode presets to Standalone mode?

Not directly, but there is a simple method to get a Hosted mode preset into Standalone mode (and vice versa). Just do the following:

1. In Hosted mode, select the preset you want to transfer.
2. Copy the preset via the *Edit menu* or keyboard shortcut.
3. Switch over to Standalone mode.
4. Paste the preset via the Edit menu or keyboard shortcut.
5. Click the “SAVE AS” button and give the preset a name.

Now your Hosted mode preset will be in Standalone mode. All of the output ports should automatically change to the correct device (e.g. if Hosted mode was using SoftStep Share it will now use SSCOM Port 1 in Standalone mode).

The reverse (going from Standalone mode to Hosted mode) can be done as well, just switch the words “Hosted” and “Standalone” in the above instructions.

Can I import my old presets from version 1.21?

Yes. The Advanced Editor allows for importing presets from the previous editor, 1.21. To import old presets to the new editor, do the following:

1. Open up the Advanced Editor.
2. If you want to import Hosted mode presets, skip this step. If you would like to import Standalone mode presets, switch over to Standalone mode by clicking the Hosted/Standalone switch.
3. Go up to the File menu in the menu bar and select “Import Hosted/Standalone Presets from V1.21” (it will say either “Hosted” or “Standalone” depending on which mode you’re currently in).

4. When the file browser appears, navigate to and select the old SoftStep editor’s “Presets” folder (not the contents of the folder, just the Presets folder itself), then click Choose/OK – the presets will be inserted at the end of the current preset list.

The Basic Editor does not provide this same functionality.

Presets created within the SoftStep 2.0+ editors should remain backwards compatible – so you can simply use the Export Preset and Import Preset options.

**Can I rip presets from a SoftStep into the editor?**

No, the SoftStep does not support ripping presets from the board onto a computer. This is why it is very important to always back up your presets if you do not want to lose them – they cannot be retrieved from the SoftStep itself.

If you want to rip presets in order to transfer them over to another computer, you should instead use the Export Preset option in the File menu of either Basic Editor or Advanced Editor – then import them on the other computer using the Import Preset option (also in the File menu).

**Will my SoftStep 1 work with the SoftStep 2.0 editors?**

Yes, SoftStep 1 hardware will work just fine with the SoftStep 2.0 editors. There are some options that are exclusive to SoftStep 2 hardware, but the editor can detect what version is connected and adjust accordingly.

**What is the difference between SoftStep 1 and 2 hardware?**

The SoftStep 2 hardware incorporates a number of changes, including:

- New cruciform key shape – including the Nav Pad
- Raised back row of keys for easier access
- Keys use LEDs for lighting, not EL wire
- Faster internal processor
- State recall in Standalone mode

Other than the above, each version should act exactly the same. The devices even show up as the same name (“SSCOM”) so any old projects/sessions/setups made with SoftStep 1 should work with SoftStep 2 (assuming they’re using the same preset).

**I have both a SoftStep 1 and 2 – do I need to do anything special?**

Nope. Both the SoftStep 1 and SoftStep 2 hardware are completely compatible with the editors. Aside from the differences listed in the previous question they should behave the same. Just note that only one SoftStep can be edited at a time using the editors.
Can I copy/paste keys?
Yes. While the copy/paste buttons of old have been removed from the key boxes, copying and pasting keys is still possible in the Advanced Editor.

1. In the main window, click anywhere on a key’s background (anywhere that is not the “open modulation window” button or the “key name” box) – this selects a key for copying/pasting.
2. Go up to the Edit menu in the menu bar and select “Copy Key” to copy the selected key – select “Paste Key” to paste to the selected key. Alternatively, keyboard ninjas can just press [Command+C] ([Ctrl+C] on Windows) to copy, and [Command+V] ([Ctrl+V] on Windows) to paste.

Can I control the SoftStep LEDs/Display from an external source?
Yes. The SoftStep LEDs and display can definitely be controlled from an external source. Please see the External Control of SoftStep section for more detailed information.

Why does my SoftStep make a humming/buzzing sound? Can I make it stop?
SoftStep 1 hardware uses electroluminescent wire (EL wire) to light the keys – this is the cause of the buzzing sound. The sound should not be present in your audio chain, just physically coming from the SoftStep. The only way to make this completely go away is by turning off the backlighting. This can be done in the Settings section of both the Basic and Advanced editors.

SoftStep 2 hardware should not hum or buzz at all.

Can I use a USB hub with the MIDI Expander?
No. Plugging a USB hub into the EXPAND port on a MIDI Expander will not work, and will not allow for multiple SoftSteps to be used with a single Expander. The SoftStep must be plugged directly into a MIDI Expander for it to work properly.

Will the MIDI Expander work with non-KMI controllers?
No. Only KMI USB MIDI controllers will work with the Expander’s EXPAND port. Plugging another USB MIDI device in will result in no MIDI being output.

What is a modline?
A modline (short for “modulation line”) is a collection of settable options/parameters in the Advanced Editor that define how a SoftStep key should act. They let you select the type of data, how the data should be processed, and how to output the data.

This is where all the action happens. She who controls the modlines, controls the SoftStep universe.
Will SoftStep work with [insert software/hardware here]?

If the software or hardware in question can receive MIDI messages, it will work with the SoftStep. Note that most hardware will require a MIDI Expander in order to connect via MIDI cables.

I have a synth/pedal/amp/rack/etc. with a USB port on it. Can I just plug the SoftStep directly into it?

It depends.

In order for the SoftStep’s USB connection to work properly, it must be connected to a device that can act as a USB “host”. Host devices almost always have a USB A connector on them (the more rectangular-shaped connector, like the ones on a computer). A non-host device, or “slave”, generally has a USB B connector (the more square-shaped one, like on the SoftStep).

So, typically, if a device has a USB A connector on it there is a good chance the SoftStep will work with it when directly connected via USB. If a device has a USB B connector on it that generally means it won’t work.

My SoftStep won’t connect to the editor but it shows up in [insert application here]. What do I do?

If the SoftStep is not connecting to the editor but is showing up in other applications, there are a few things to try out.

1. Try unplugging the SoftStep and plugging it back in. On Mac OS there can be some connectivity problems due to a potential bug in CoreMIDI. This can also help out on Windows machines as well.

2. If you plugged the SoftStep in after opening the editor, try it the other way around. Connect the SoftStep, then open the editor. If you’re already doing that, try it the other way. The order of operations can affect the results.

3. Try restarting the computer. It’s amazing how many infuriating tech headaches can magically disappear with a computer restart.

4. If you’re on Windows, make sure all other audio/MIDI applications are closed before opening the editor. See this question for more information on why this works.

5. As a last resort, try manually reinstalling the firmware on your SoftStep. This is essentially a factory “reset”.

6. If none of the above options solves the problem, contact KMI tech support.

My expression pedal isn’t working, what do I do?

First, you should check and make sure the proper connector is being used. Expression pedals use TRS (tip, ring, sleeve – or “stereo”) connections – one for ground, one for +5V power (voltage may vary), and one for the actual pedal signal. The SoftStep’s expression pedal input jack requires a 3.5mm (1/8”) TRS plug. Most expression pedals come with 1/4” TRS plugs, so
we provide a 1/4" to 3.5mm TRS adapter with the SoftStep package. Use that. If you need a replacement, just make sure it’s a TRS (stereo) adapter, not a TS (mono) adapter.

Second, you should check and make sure you’re actually using an expression pedal. It can be tough because while the term “expression pedal” does have established standards, they’re not always followed. Some companies say “expression pedal” when it’s actually a “volume pedal” (there is a difference) – some do the opposite and call expression pedals volume pedals. Sometimes the potentiometer (often shortened to “pot”) inside has a different resistance which can lead to different behavior between pedals. Some have a different “taper” (or “curve”) resulting in different values across the pedal’s travel. At KMI we use Roland EV-5 expression pedals without issue.

Third, check to make sure that your expression pedal operates on the correct voltage. All KMI gear operates from 0 to +5 volts. If your expression pedal goes beyond that there will be a lot of pedal travel that appears to do nothing.

⚠️ Note: Volume pedals do not work with the SoftStep or any KMI controller with expression pedal input – at least, not without some modifications... With some basic soldering skills a volume pedal can be modified into an expression pedal. There are also some workarounds: [http://www.strymon.net/2011/10/10/strymon-tech-corner-3-volume-pedal-as-an-expression-pedal/](http://www.strymon.net/2011/10/10/strymon-tech-corner-3-volume-pedal-as-an-expression-pedal/) Also note that most volume pedals use logarithmic tapered pots as opposed to linear pots – this will have an effect on the curve/response of the pedal.

**Does MIDI sent to the Expander’s input get passed out the MIDI Out? Like a MIDI Thru?**

No, the MIDI Expander’s input does not behave like a MIDI Thru (pass the input out the output). The Expander’s MIDI input is exclusively for getting MIDI into a connected computer (like a MIDI interface) or for external control of the SoftStep.

**MIDI notes are always an octave off in [insert software here]. Is something wrong?**

Nope.

There are actually multiple MIDI note number to note name conventions – different companies follow different standards. KMI follows the C3=60 paradigm (as does Ableton, Logic, MainStage, and more), while other companies follow the C4=60 paradigm (Native Instruments and others). It’s even possible to run into a C5=60 standard, but that is much more rare.

If all MIDI notes appear to be an octave off, it simply means there are two different note naming standards involved. It’s only the note number that matters – the name is irrelevant.

**SoftStep only shows up as “USB Audio Device” when connected. Is something wrong?**

Nope, nothing is wrong – you’re just using Windows XP. Windows XP lists any class-compliant USB MIDI controller as “USB Audio Device”, rather than the actual port name. The correct port name should be displayed on Windows 7 and 8, as well as all versions of Mac OS.
If you would rather it show up as something else, it is possible to change the displayed port name. Instructions on how to do this can be found at this link: https://forum.ableton.com/viewtopic.php?f=4&t=176816

I see there is a new update. Should I update right now? The day before my show?

No.

When there’s a new update available it can be very tempting to get it and update as soon as you possibly can. While there’s nothing wrong with this urge, if you happen to have a show coming up anytime soon (or today), it is generally advisable to hold off on updating until after your show has passed – or at least keep the old versions so you can go back if the need arises.

While we test everything to the best of our ability, there’s no telling what bugs may be introduced to your setup – the preset you’re using may have changed in a subtle way that you don’t notice; there could be a nasty bug that didn’t get noticed because it only appears in very special circumstances; the new firmware may not like one of your other devices; or it may respond to MIDI in a slightly different, perhaps undesirable, way. Even fixing a bug with an update can cause problems if you’ve already grown accustomed to the “buggy” behavior and developed the muscle memory around it.

Always, always give yourself time to test things out before changing your performance setup. Always. You will be much less stressed if you know what to expect from your gear and software. This is an extremely useful suggestion for pretty much anything performance-related, not just the SoftStep.
5.13 Safety Precautions

Medical Devices
SoftStep may emit electromagnetic fields. These electromagnetic fields may interfere with pacemakers or other medical devices. If you wear a pacemaker, maintain at least 6 inches (approximately 15cm) of separation between your pacemaker and SoftStep. If you suspect SoftStep is interfering with your pacemaker or any other medical device, stop using SoftStep and consult your physician for information specific to your medical device.

Medical Conditions
If you have any medical condition that you believe could be affected by SoftStep (for example, seizures, blackouts, eyestrain, or headaches), consult with your physician prior to using SoftStep.

Explosive Atmospheres
Do not use SoftStep in any area with a potentially explosive atmosphere, such as a fueling area, or in areas where the air contains chemicals or particles (such as grain, dust, or metal powders). Obey all signs and instructions.

Repetitive Motion
When you perform repetitive activities such as playing the SoftStep keys, you may experience occasional discomfort in your hands, arms, wrists, shoulders, neck, or other parts of your body. If you experience discomfort, stop using SoftStep and consult a physician.

High-Consequence Activities
SoftStep is not intended for use where the failure of the device could lead to death, personal injury, or severe environmental damage.

Choking Hazard
Some SoftStep accessories may present a choking hazard to small children. Keep these accessories away from small children.